Movavi PDF Editor 2

User Guide

Quick start guide

Opening files
Editing documents

Saving files




Table of Contents

L@ T Tor 1) = o U o [ SRR 2
(S eV To = 1= T] (T3 1T o P 3
GEttiNG AN ACHVALON KEY .....eiiiiiii oot e ettt et e e oo oo e e et oot ettt et eteeeee s e e e e eeeeeeeeaeeaateeeeeeseaeesssssasssas e e eeeaeaeaaaeaasaseesssenessnnrnns 4
F o3 1AY=L (] T T = 19 o [ (o PSP 4
Fa e 1AY=L (T T T 0T T UL 1 ] (T 1 1Y PP 5
(O 01T o Ta o I 111 PSSO SO PSR 7
(e To ] 0 =1 To I 0 F= AV o =1 (o o 1 USRS 8
(@ (=Y L g To I 1=V 1T PP PPPUPPPPPPN 9
a0 o [T (5« PSPPSRI 9
o Lo [T o T T ¢ F= o =S PRSPPI 10
o Lo [ To =TT [ E= LU= PRSPPI 11
T 1111 Vo PRSPPI 11
1 =T aE=To 1o I oT=To 1= S PRSP 13
L@ (o =T T4 g o I oF=Te 1= T3P PERPPPRPP 14
N [ 1T o T 1= TP PPPPSPPURPRN 15
(0] o)V TaTo BF=Tale oY= 1Sy 1 a o N o 7= 1= TSP UERPPPRPP 16
(RN ] 2= 1 (] ale [l o¥=To =Y PSPPI 17
DT =Y o T o = To = SR RRRPPPRPP 18
1YL= o TaTe e (oot ULa =T o) TSR 18
= T T T 0 Y= T 1= PSSP 20
SAVING PAGES AS IMAGES ... iiiiii i e e e e eiieeeeeeee ettt e e e e st e eeeeeaaaaeaeae e e et e e e e e e esssssssaasaa e eaeaaaeaaaaeaaaeeseeeeeeesssssssssas e e e eeeeeeeeeeeeaaaeeeeteeaeennrrnnnnas 21
S T= AV o I 11T PP P PP UPPPPPUPRRPN 22
[ (=Y o= T To IS U o oo S PRSPPI 23
Y (=T I =T (01T =T g =Y oL TSP PRRPPPRPP 23

Movavi PDF Editor

Quick Start Guide

Movavi PDF Editor is a powerful and user-friendly tool for convenient PDF document management.

Step 1: Open a document
Drag and drop a file from Windows Explorer onto the Movavi PDF Editor window, or click Open File to open a document.

DCvag and drog your files here

More on opening files

Step 2: Edit the document
Click the Manage Pages button at the top of the window to see the editing options.
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More on editing documents

Step 3: Save the file
1. Click the Save button at the top of the window.
2. In the dialog box, click the Overwrite button.

World society theory

- * Argues that domestic political debates and policy reforms are decisively
influenced by a supranational cultural and discursive order that carries with
it normative principles of appropriate political goals and structures,

* International cultural connections are particularly strong in Europe, which
stands out as “the most densely integrated region” of the globe.

* Policies tend to spread more rapidly when they conform to general
v g supranational values,

(1]

More on saving files
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Removing trial restrictions

When you first install a copy of Movavi PDF Editor, it will be running in trial mode. You will be able to use all the features of the program for 7
days. The trial watermark will be applied to the pages of your documents when saving the files. To be able to use the program to its fullest
after the trial period expires, you will need to activate it using an activation key that you can purchase from our official website or any of our
partners.

7)p: you can delete the trial watermark from your documents after activating the program — simply open the file in the full version and save
it once again.

Follow the instructions below to activate your copy of Movavi PDF Editor:

Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.

Buy Activation Key

2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase form. IMPORTANT! Be
sure to enter a valid e-mail address: it will be used to deliver your activation key.

3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from support@movavi.com containing
your activation key.

Step 2: Open the activation window
1. Open Movavi PDF Editor.
2. Open the Help menu and choose Activate Software. The activation window will appear.

Or click the key button n In the top right-hand corner of the window.


https://www.movavi.com/pdf-editor/buynow.html?asrc=pdfe_help
https://www.movavi.com/pdf-editor/buynow.html?asrc=pdfe_help

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 3: Enter your activation key

1. Enter the activation key into the corresponding box.

2. Click Activate to complete the activation.

This step requires a working Internet connection to verify your key. If you aren’t connected to the Internet, try offline activation.

Please enter your activation key:
|DDDDDD-11111-22222-33333-44444-55555-66666 |

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Having problems with activation?

If activation Is not working as expected, try the following:

» Make sure that the activation key Is entered correctly and Is intended for the program you are activating.
* Try activating offline via e-mail.

» Contact us at support@movavi.com and we'll help you solve the problem!

Activating without Internet access
If the computer you have installed Movavi PDF Editor on is not connected to the Internet, you can activate the program via e-mall.

Movavi PDF Editor

Getting an activation key

You can purchase an activation key from the official Movavi website or from any of our partners. To purchase a digital copy from the official
website, follow the steps below:

Step 1: Go to the purchase page
To open the purchase page for Movavi PDF Editor:
+ In the Help menu, choose Buy Activation Key

» Click the cart button . In the top right-hand corner of the window, or...
» Follow the link below...

Buy Activation Key

Step 2: Choose a license type

- If you plan to use Movavi PDF Editor at home, click Buy Now on the purchase page to proceed with buying the personal license.

- If you plan to use Movavi PDF Editor at work, in a government institution, or gain profit in any way, go to the Business license tab on the
purchase page.

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners are
secure and completely safe.

Step 3: Fill in your billing details

1. Choose any of the available payment methods.

2. Fill in the information required on the page.

3. Enter a valid e-mall address. This e-mail will be used to deliver your activation key.

Step 4: Get your activation key

After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.
Activation instructions

Activating without Internet access

If you haven't received your activation key within the hour:
» Check the Spam folder of your mailbox,
« Contact support.

Movavi PDF Editor

Activating PDF Editor
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Activating Movavi PDF Editor will let you use the program to its fullest forever. Activation requires an Internet connection to verify your key.

You will need:
» Movavi PDF Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
* Internet access to verify your key. Don't have Internet access? See this guide on offline activation

Step 1: Open the activation window
1. Launch Movavi PDF Editor.
2. Open the Help menu and select Activate Software. The activation window will open.

Or click the key button n In the top right-hand corner of the window.

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 2: Enter your activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.

2. Click Activate to verify your activation key.

This step requires a working Internet connection to verify your key. If you aren’t connected to the Internet, try offline activation.

Please enter your activation key:
|DDDDDD—11111—22222—33333—44444—55555—66666 |

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the activation process and
restart the program.

Having problems with activation?

» Check that the activation key is entered correctly and is intended for the program you are activating.
- Try offline activation,

» Contact our support team.

Movavi PDF Editor

Activating without Internet

Activation requires Internet access to verify your activation key. If you don't have a working Internet connection on the computer that Movavi PDF
Editor is installed on, you can activate the program via e-mail using any other computer or device. You will be asked to send us an automatically
generated e-mail and then enter the reply into the program’s Activation window.

You will need:
* Movavi PDF Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
+ A device or another computer that can be used to send and receive e-mail.

Step 1: Open the activation window
1. Launch Movavi PDF Editor.
2. Open the Help menu and select Activate Software. The activation window will open.

Or click the key button ﬂ In the top right-hand corner of the window.

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 2: Enter the activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Select the Activate offline option.

3. Click Activate to proceed to the next step.
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Please enter your activation key:
000000-11111-22222-33333-44444-55555-06666

Don't have an activation key? Buy now Paste
Activate offline (by e-mail)

Need help activating? ‘ Cancel

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your program.

Please copy this text and e-mail it to us at reg@maovavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-60666
Hardware ID: 1057-5AEF-38F3-4514-0574-0000-0000-2701
Product ID: pdfeditor2
E-mail: reg@movavi.com

Copy

After yvour request has been processed, yvou will receive your registration
key via e-mail. Copy the registration key and paste it into the appropriate
box below.

Enter your registration key:
Paste

Need help activating? ‘ Back

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer or device that you
will be sending the e-mail from.

2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information you've copied earlier into
the message body and send this e-mail to reg@movavi.com. The activation server will then verify your activation key and send you an automatic
response containing a registration key, which you will need to enter into the Activation window. You should receive the server's reply within an
hour.

Activating PDF Editor

Registration Robot (regi@movavi.com)
Activating PDF Editor

Please copy this text and e-mail it to us at regi@movavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-66666
Hardware ID: 1057-5AEF-38F 3-4514-0574-0000-0000-2701
Product ID: pdfeditor2

E-mail: reg@movavi.com

Bl : o a @0 saved | | -

Step 4: Enter your registration key

1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.

3. Click Activate to submit the information.



mailto:reg@movavi.com

Please copy this text and e-mail it to us at reg@maovavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-60666
Hardware ID: 1057-5AEF-38F3-4514-0574-0000-0000-2701
Product ID: pdfeditor2
E-mail: reg@movavi.com

Copy

After yvour request has been processed, yvou will receive your registration
key via e-mail. Copy the registration key and paste it into the appropriate
box below.

Enter your registration key:
| MIBSAHHT-CQYECAZ T-WHEISCFB-IIRSDSB-QP TOTDLV-MIBSAHHT | Paste

Need help activating? ‘ Back ‘

Once activation Is complete, you may be asked to restart the application.

If you're having problems with offline activation:

+ Make sure that the keys are entered correctly and are intended for your version of Movavi PDF Editor.
» Make sure you have administrator rights on your computer.

- Contact our support team.

Movavi PDF Editor

Opening files

Drag-and-drop
Find the necessary document in Windows Explorer and then drag right onto the Movavi PDF Editor window.

Cvag and drog your fles here
or

B Open File
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Browse
On the start screen, click the Open File button. A Windows Explorer dialog box will appear. There, choose the necessary file and click Open.

e |
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Recent files
On the start screen, you can see the thumbnails of recently opened files. Click on a thumbnail to open file.

I
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Drag ard drop your fles hens i EEEi

ar

Student's book. pdf Document.pdf Baok.pdf Documentl.pdl

You can also find the list of recently opened files in the File menu. Hover your mouse pointer over the Recent Files and select the file you want to
open from the pop-up Mmenu.

File

Create Mew File Ctrl+M

Dag amd drop your flies here
or

Open... Ctrl+0

Recent Files - Document.pdf
Mew Tab Book.pdf
Merge Files Presentation.pdf

Employment Agreement.pdf

File menu
Open the File menu and choose Open. A Windows Explorer dialog box will appear. There, choose the file you want and click Open.

Movavi PDF Editor

Zoom and navigation

Go to Pages view | Page navigation Zoom controls |

QO @ 100% v

Chapter ].

“Well, Prince, 50 Genoa and Lucca are now just family estates
of the Buonapartes. But | warn you, if you don't tell me that
this means war, if you stll try to defend the infamies and hor-
rars perpetrated by that Antichrist=I really belicve he is Anti-
christ—] will have nothing more to do with you and you are no
longer my friend, no longer my “faithful slave,’ as you call your-
self! But how do you do? I see 1 have frightened you—sit down
and tell me all the news.”

It was in July, 1805, and the speaker was the well-known
Anna Paviovna Scherer, madd of honor and favorite of the Em-
press Maryva Fedorovna, With these words she greeted Prince
Vasili Kuragin. a man of high rank and importance, who was
the first to arrive at her reception, Anna Paviowna had had a
cough for some days. She was, as she said, suffering from la
gqripps: gnpps Deing Ehen a ne WO in Patersbarg LAY

Navigation
Use the page navigation controls at the top of the page or the mouse wheel to flip through pages.

Zoom
When you open a document, it will be shown In its actual size. Use the zoom and navigation tools at the top of the window to set a comfortable
view. You can also zoom in and out using the mouse wheel while holding down Ctrl.
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Creating new file

To create a new file, click the File menu and select Create New File.

File  ——
Create Mew File Cirl+M

Open... Ctrl+0

Recent Files - Exmployment Agrecment (Samplk)

Mew Tab Cirl4T

AGREEMENT made a5 off the _ iy o LM herwen
ol ermployed] a corpustalion incorpoeated undot the Lims of the Provisce of Oalase,

i s prscpal place of businew (ke "Emploser™r
g of cmpleype], of the City of in the Provesae of Oatars
Employee )

Merge Files

Save Ctrl+5

- — B IRLLAS the Emiployer desiees wo obtain the Benefin of the services of e Emgloves. and the
Save As... Ctrl+5hift+5 pvoe desines fo pendler swch sorviors on fse bers andd conditions sel fovth
Print Cirl 4P SSIDERATION of thy promises and ofhor pood and valuably considoration (thy

rnt Cirl+F Py aned receipt of which are hereby acknos ledged) the parties agree s folloss:

Exit frormem

Errployee sgrecs thal he will @ all times Ganlbdfullly, sssheirsously, and 1o e beut of his aliill,
Bility. oxponicncy and taleng, perforss all of the duties soqeised off his poasion, In carrying oui
these duthes i respodnibilities, the Emploves shall comply with all Emphover polices,
proceduses, rales snd pepelateons. both wivmen and oral. i are annosnoed By dhe Emploer from
time b0 B, b is sl usderiond] and sgrood 1o by the Essployoc that kis sodgnment, detics and
resguamibilities and repomng smangemosis. may be chasged by the Employer in its sole
discretaon willsoul caming berrmmation of this agrecment

2, Position Tk

Aua , the Emphiyer in rquired ta perform the fulkwing dutics and undertale

i o] hivm ) cated b lgags Ol L T
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Adding text

To add text to your document, click the Edit button and select Text from the pop-up menu.

. [Proshastion Period

i i underuond and sgroed thai the first mescty days of omp conatitete 3
prohatiasry peariod dering which perod the Esploper may, i 05 Ssedile drcrethon, lormmale
the Fmxployoe's employmaeni, for amy neann without notios o cau

7. Performance Rovicws

The Emngloyes will be provided with s writien per appraiial af kead ence per year and
sl apprainal will be pevicwed ot which time all aspocts of the swevsent can be Fally discuacd

The Employes may sl any tims Ehin ap arad b el i by

prving nod less il two weeks Wil eice 10 the Emphover

i) The Employer may ierminate this Agreement and the Employes’s employment al
afry i, within! Bolice of paymcsl in Bon of Bolice, fof ulfcient came

(4] The Employer may icrminaic ihe employmens of the Employes ai any time

withicasl the poguiremest 1o b wsllicienl caune puiuast 1o (b sbeve, providad

the Employver pays to the Emploves sn amound ax requingd by the Employmen

Standieed Act 2000 or other such kegislation an may be i offoct af the time of

terminaticn. This paymeni dhall cofmmnale the employess eatire etithement

armung friem i germintion

) The ermployse agrees W rovers ay popery ol
al the B of lcrminatios

Set the font, style and size on the right-hand panel. Place the cursor where you want to add the text and start typing.
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Click on an empty space In the document to save changes.
Movavi PDF Editor

Adding images

To add a signature to your document, click the Edit button and select Image from the pop-up menu.

Data and methods

The authors use event histary methods and a pooled cross-sectional
time-series dataset on 29 European countries (including all 27 EU
mermber states plus Norway and Switzerland) for the years 1988 to 2009.
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You can move the image by simply dragging it.
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Data and methods

The authors use event history methods and a pooled cross-sectional
time-series dataset on 29 European countries (including all 27 EU
member states plus Norway and Switzerland) for the years 1988 to 2009,

Movavi PDF Editor

Adding signatures

To add a signature to your document, click the Edit button and select Signature from the pop-up menu.

Signature

IN WITNESS WHEREDF ithe Employer han caused this apreement b be
enceutod by its dhly ssstheorired offieces sl the Easplegee hus 1t his hasd
an off the daie fird above writien

SHENED, SEALED AND DELIVERELD b the pressnc: of

[ e ool emplosyee |

|Sigratery of Emphnyee|

|Wasse ol Empleyer Eep|

|Signumere of Employer Regl
[Tatke

Draw your signature in the opened window and click Add.

Draw Image

settings: e e ©. . color

Set size and

Draw your
signature

Move the signature where you want it and save the document.
More on saving files

Movavi PDF Editor

Editing
Click the Text button on the top left corner of the window.

11



Emplovment Agreement {Sampley

THE AGREEMENT made moof b dayol 1k Bedwecn
[rarma o conpskonyr | @ corosased sl peaaind wsakor the L of 2w Pravingg o Unsana,

and Borving its. principad placy of besingss a1 dthe “Fmployer
] i off cmaplovee], of the Oy ol __ i e Provvinsoe of Omlsfio

iihe “Emploee™)

WHEREAS the Employer devires b obtain the hosefil of e services of the Employoe, asd the
Employee desines o sender sach services om the torms and cosditions. i fonh

N COMSIERATION of i profmesss sl olher pood sl valuable cosnideratson {lhe
sulficiency and roccipt of which ang Bereby scknoswlodped ) the parties agreg as Follows:

1. Employment

Thee Emghoryee agrees diat e will o all imes faithfully, induarioasly. snd oo il bes of ba cidl
ability, eaperinncs ssd talenty, perform ol of the dulics roquired of kis positios. In carying ot
these deties @ pesponalites. the Rmgdovee shall comply wish all Emphover policies.
procedures., nukes s regulations, bah writken @ oral, as @ ansousced by the Emgdover from
e lo i E is adeo underubond s agreed b by e Employee thal b i pamen, duliey s
pesposmabilition and reporting arsspements may be changed by ta Employer in m soly
diictee mitheul < aunstg Beirmfalen of By apicemenl.

2, Penition Ttk

Asa . the Employes i reguired 1o perform the follrming detics snd undetake

Text

To edit text in your document, double click on the line you want to edit.
Important: Movavi PDF Editor supports Times New Roman, Arial and Courier New fonts. Text of any other font will be automatically changed to
Times New Roman.

and |name of emplayec], off the City of in the Peovinee of Cintanio
ithe “Emgployes”)

WHEREAS the Employeer desires 10 obeain the: henelin of ghe sevvices of the Employes, and the
Employves desines o nender such services o the terms and cosditioss. st fonh

1N CONSEERA TN of the dthe
sulficicncy wd rccipt of Ih‘:‘:ﬁ:{ DOUBLE-CLICK E.“h;
I, Employ=scni

The Employee agrees that he will at all imes faithfully, industrioushy, and to the best of his skill
SERlny, EApCTROnCE aied talnis, pericamn a1l of (he el requined < Bas posiiion. In caTying oel

e it s penpromatilition, the Employre shall comply with all Esphoyer pobacics,

prexmbures, iukes assd egulations, buth weitlen asel oeal, an ate snseusced by the Employes fnom

s i i B ia also undonsond ssd agroed o by the Employes that hiv s grmeni, duties and

Eenpueipa®alines sl Beporlifg atasgements may By changad Ty e Essphner m s sole

discretion without causisg Sermination of thin agrocenl

2 1. Puritmon Titke
—— Ana - thee Emiplowyee i pequained 10 pariom the Sollowing dutirs ssd undomake
e fellowing respodmibilitics in & profciionsl manter,
fak.
e e B -
(L
-
feh Onher duties @ may arise (Tom e (o time s as may be wmsiged 10 the emphoves
¥

Rt

To change the position of the line, simply drag it to the new position.

and |name of employec], off the City of
ithe “Emgployves™)

in the Provines of Ontarnio

WHEREAS the Emploser desines 1o osain the henefit of ghe services of the Emiployes, and the
Eropdoyee desines o nender such servioes om the terms and cosaditions. wei Torh.

IN CONSEERATHON of the promises s cther pood and valsable cosmideration {the
silficiency wmd pecepe of whech e hevelry chonewbaldged) the pares agnee as Follews:

[ —
The Employee agrees that he will at all

fully, mdustrioushy, and to the best of his skill,
Ty, CApETRDTe T ] TAkTHE, P M TOaquiTed o Bas posiiion, 1N CaTyIng oul

e dutacs s sespomabalitess, the Emplo I corrgply winh alll Essploper polacics,

provedures, fubes sl regulstions, both weillen sl ofal, as afe snfsusced by the Emgloyer Insm

o i i I8 in s undionsond ssd aproed o by the Emploves that hiv swigement, duties asd

penpoiraliiney s sepoiifeg aifafpement may be Chaiped Ty e Essplower s il wde

discrotion withoul cauasg Sormination of thin agrocsseni

1
1. Puritwon Titke
map Asa - thee Emiplosyee ix rosairesd 10 paor{ o they Bodbossing dueters s undonake
the Fellirwing regumibilities in s profoionsl mansc,
fak-
vy ) -
i -
il -
(el Uaher duies as may s (rom s 10 tims ad as may be ansigeed w0 the employes
¥

Pl e

Images

Click on the image to select it.
Simply drag the image to move It.
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To rotate or delete the object, right-click on it and choose one of the options from the pop-up menu.

Movavi PDF Editor
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Managing pages

Pages mode

To switch to page managing mode, click the Manage Pages button on the top panel.

Chapter 1

“Well, Prince, s0 Genoa and Lucca are now just family estates
of the Buonapartes, But 1 warn you, if you don't tell me that
this means war, il you still try to defend the infamies and hor-
rors perpetrated by that Antichrist—I really balicwve ha is Anti-
christ—I will have nothing more to do with you and you are no
longer my friend, no longer my “faithful slave,’ as you call your-
self! But how do you do? 1 see | have frightened you—sit down
and tell me all the news.*

It was in July, 1805, and the speaker was the well-known
Anna Pavlovna Scherer, mald of honor and favorite of the Em-
priess Marva Fedorovna, With these words she grected Prince
Vasili Kuragin, a man of high rank and importance, who was
the first to amive at her reception, Anna Pavievna had bad a
cough for some days. She was, as she said, suffering from la

H i ]

You will see pages' thumbnails. On the right-hand panel you will see editing options:
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Blank Page

Append Files

Copy
Paste
Rotate
Delete

Extract

Convert to JPG,
PMNG, BMP

B Do O B K

1% 14 1% 15 ir

n Blank page. Inserts a blank page in a selected position.

Append file. Adds all the pages from a selected file at the end of the document.

n Copy. Coples selected pages.

Paste. Pastes copied pages next to a selected page.
Rotate. Rotates selected pages 90° clockwise.

H Delete. Deletes selected pages.

E Extract. Saves selected pages as a new PDF document.

u Convert to JPG, PNG, BMP. Saves selected pages as images.

You can also find the editing options in the Pages menu:

Pages

Copy
Paste

Delate

Rotate Left

Rotate Right

Rotate 180°

Extract
Convert to JPG, PNG, BMP

Learn more: Organizing pages | Rotating pages | Deleting pages | Extracting pages | Saving pages as imagages
Movavi PDF Editor

Organizing pages

Step 1. Select the page you want to move by simply clicking on it. To select multiple pages, click on them while holding down Ctrl on your
keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.

14
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Movavi PDF Editor

Joining files

Step 1: On the right-hand panel, click the Append File button.

+ Append Files

Step 2. A Windows Explorer window will open. Choose the file you want to append and click the Open button.
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Step 3: All the pages from the selected file will be added at the end of the document. Now you can move them as you wish or delete pages you
don't need.

Learn more:
Organizing pages
Deleting pages
Movavi PDF Editor

Copying and pasting pages

Step 1: Select the page you want to copy. To select multiple pages, click on them while holding down Ctrl on your keyboard. To select multiple
pages that are next to each other, click on the first and the last page while holding down Shift.

Step 3: Go to the document you want to paste the copied page in. Select the page after which you want to paste the copied page. Then choose
Paste on the right-hand panel.
You can also right-click on the page and select Paste from the context menu.
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Movavi PDF Editor

Rotating pages

Sometimes pages in scanned document have wrong orientation. With Movavi PDF Editor you can easily fix them.

In viewing mode: right-click on the page you want to rotate in preview panel. To select multiple pages, click on them while holding down Ctrl on
your keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.
Then select one of the Rotate options from the context menu.

Copy

Paste
Delete
Rotate Left

Rotate Right

Rotate 180°

BExtract

Convert to PG, PNG, BMP

In managing mode: select the page you want to rotate. To select multiple pages, click on them while holding down Ctrl on your keyboard. To
select multiple pages that are next to each other, click on the first and the last page while holding down Shift. Then choose Rotate on the right-

hand panel.
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You can also right-click on a page and select one of the Rotate options from the context menu.
Movavi PDF Editor

Deleting pages

There are several ways to delete a page in Movavi PDF Editor.

In viewing mode: right-click on the page you want to delete in preview panel. To select multiple pages, click on them while holding down Ctrl on
your keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.
Then select Delete from the context menu or press Delete on your keyboard.
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In managing mode: right-click on the page you want to delete in preview panel. To select multiple pages, click on them while holding down Ctrl
on your keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift. Then
choose Delete on the right-hand panel.

You can also right-click on the page and select Delete from the context menu or press Delete on your keyboard.
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Movavi PDF Editor

Merging documents

Step 1. Select Merge Files on the start page.
18
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Merge Files
B e

Step 2. The merging window will open. Click Select Files to add files from an Windows Explorer window or simply drag and drop them onto the
window.

Add POF or image files by dicking the button belaw or drag and drop them here.

|0 Select Files l

Step 3. Rearrange files by simply dragging them to the desired position.

To delete a document from the list, click on the cross button next to It.

Step 4. Click Merge. The new merged file will be opened in a new tab and you will be able to continue editing.

19



See also: Joining files
Movavi PDF Editor

Extracting pages

Step 1. In Manage Pages mode select the page you want to extract. To select multiple pages, click on them while holding down Ctrl on your
keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.
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Step 3: A Windows Explorer window will open. Choose where you want to save your new document and the file name. Then click the Save
button. The selected pages will be saved as a new document.
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Movavi PDF Editor

Saving pages as images

Step 1. In Manage Pages view mode, right-click on the page you want to save as image. To select multiple pages, click on them while holding
down Ctrl on your keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.
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Step 2: On the right-hand panel, choose Export to JPG, PNG, BMP. You can also right-click on the page and select Convert to JPG, PNG, BMP
from the context menu.
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Step 3: A Windows Explorer window will open. Choose where you want to save your file and the file name. Then click the Save button. The
selected pages will be saved as separate images.
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Save astype |PNG (*.png)
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Movavi PDF Editor

Saving files

To overwrite the existing file:
Click the Save button in the top left-hand corner or open the File menu and click Save. In the dialog box, click the Overwrite button.

{3 '_ World society theory

To save document as a new file:
Step 1: Open the File menu and click Save As.

File

Heln

Create Mew File Ctrl+M

Open... Ctrl+0

Recent Files -

Mew Tab Ctri+T d society theory

MEFQE Fileg B< that domastic political debates and policy reformes are decisivaly
Save Ctrl+5

Save As... Ctrl+5hift+5

Print Cirl+F

Exit

Step 2: In the Save File dialog box, choose where you want to save your file and the file name.
Step 3: Finally, click Save.
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See also:
Extracting pages
Saving pages as images

Help and Support

If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.

Write to us at suppport@maovavi.com
or click the button on the right to ask a support specialist via live chat.

Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our support team
specialists may ask you for additional information that Is required to solve your problem: these may include your license key, log files, and files you
were working with, but never personal information. We value your privacy!

Have you checked the FAQ section?
Your question may have already been answered!

System Requirements

The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi PDF Editor. If your
computer meets the recommended configuration, then Movavi PDF Editor is sure to run smoothly on your computer.

Minimum system requirements Recommended configuration
Movavi PDF Editor
Operating system Windows® Vista/7/8/10 with latest service packs and patches
Processor Intel®, AMD® or compatible processor, | 2.8 GHz
GHz
Display resolution 1280x768, 32-bit color 1280x1024 or higher
RAM 2GB 4GB
Available disk space 325 MB 1 GBor more
Additional requirements Administrator permissions are required for installation

Internet connection
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